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1. INTRODUCTION 

This supplemental manual provides descriptions and instruction on ADAPT-

Builder’s latest features. These new features have been introduced to meet the 

needs for general analysis, design, and reporting capabilities and to increase 

productivity and efficiency in program use.   

These latest features can be categorized into 3 groups:  Analysis and Design 

improvements, Modeling improvements and Reporting improvements.   

1.1 Analysis and Design Improvements 

 

• 2nd-order P-Delta Analysis:  The program now includes the 

option to run 2nd-order analysis for geometric non-linearity (“big” 

P-Delta) based on the compilation of the elastic and geometric 

stiffness matrices.  A new analysis/design option type for P-Delta 

is included in which combinations can be singularly run for 2nd-

order effects or processed as a batch based on a combination used 

to obtain the geometric matrix.  Graphical analysis results similar 

to regular combinations can be obtained for P-Delta combinations. 

These results can be utilized for the design of columns.  
 

• Drift and Moment Amplification Factors: With the new P-delta 

feature, the program graphically reports drift and moment 

amplification factors (2nd/1st order results) for local axes, RR and 

SS, as well as the combined global results. The program code 

checks against a user-defined value set in the Result Browser.  
  

• Effective Flange for Beams: The program now includes the 

option to calculate the effective flange and properties of beams 

when the support line is set to Beam criteria.  The design of the 

beam sections is performed using the effective properties.  The 

component of stress related to the precompression uses the full 

tributary area of the section as does the graphical precompression 

result.  ACI and EC2 calculations for effective width are 

supported.  
 

• Punching Shear Improvements: New improvements have been 

made for punching shear according to ACI318-14.  These include: 

 

• The option to consider critical sections outside the shear 

reinforced zone with either a rectilinear or octagonal-
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shaped critical section. ACI318-14 Sections 22.6.4.2, 

22.6.6.1 

• The option to apply two-way shear provisions for minimum 

reinforcement for seismic drift. ACI318-14 Sections 

18.14.5.1.         

• Application of minimum two-way shear reinforcement at 

critical sections is based on the requirement at the first 

section d/2 from face of support.  

 

• FELT 3D and Long-Term Losses: When the PT Shop Drawing 

module is enabled, the program gives new input and functionality 

for the calculation of long-term losses for unbonded tendons and 

bonded tendons stressed at the same time.  Additional related 

features include: 

 

• FELT 3D Report – a compiled PDF report summarizing 

tendon loss calculations including graphical views of the 

tendons horizontal and vertical profile and the loss 

diagrams.   

• Drawing Editor Chair Groups – Allows the user to input 

on-demand chair bar maximum spacing and chair bar 

extensions for graphical output of tendon support bars.  

1.2 Modeling Improvements 

 

• Strip Modeling Dynamic Editor:  A new and improved Strip 

Modeling Dynamic Editor includes tools used to more rapidly 

model and modify support lines and design strips.  These include: 

 

• Support Line Wizard – creates a support based on a 

construction line defined by snap points along the strip 

path. 

• Support Line Limits – Changes selected support line design 

criteria and tributary limits for the design strip.  

• Wall – allows the user to set constraints for how walls are 

considered for design strip generation.  

• Display- Sets the support line display for Direction, Criteria 

and Width Limit 

 

• Splitter Functionality: New and improved splitter functionality. 

The use of splitters has been simplified to creating a boundary that 

the tributary edge extends when the width is required to be limited 

to either side. Splitters are no longer required for any other purpose 

as the program has been improved to recognize support line nodes 

at any location and properly generate strips.  
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• Ramp Modeling: Modeling of ramps is now supported in 

ADAPT-Builder.  Ramps are considered analytically only without 

tendons.  Longitudinal and transverse beams can be modeled at 

ramps with options to automatically offset the beams as well as 

offset walls and columns supporting ramps. Ramps are required to 

be modeled in the same plane and the program constrains the 

graphical input as 3-point input to enforce planar modeling.    

 

• Beam End Offsets: Beam coordinate definitions now include the 

ability to create unique offsets at the beam start and end points 

necessary to support inclined beams. 

1.3 Reporting Improvements 

 

• Longitudinal Reinforcement on Design Strips:  The Result 

Browser includes graphical reporting options for design sections to 

include the area of steel for provided, required and base (user-

defined) reinforcement as well as the area of steel/section area 

(rho).  

 

• Drift XLS Reporting:  New XLS reporting is available for lateral 

drift. New reports include list of vertical stations arranged top-

down with column coordinates and elevation, X/Y/Global 

displacements at top and bottom of columns, drift at columns with 

code check, maximum drift data arranged for easy plot, average 

story drift, and story drift plot data. 

  

• FELT 3D Reporting:  A compiled PDF report summarizing 

tendon loss calculations including graphical views of the tendons 

horizontal and vertical profile and the loss diagrams.   

The following chapters will provide a detailed overview of the new 

improvements and describe their use and application. Where appropriate, 

theoretical and/or design code background will be added.   
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2.  2ND-ORDER P-DELTA ANALYSIS  

2.1 Defining P-Delta Combinations 

A new design/analysis design option type is definable in the Loading 

Combination input window.  Combinations designated as ‘P-Delta’ are 

processed analytically for 2nd-order effects in one of two ways.  

Note that the allowance for analyzing P-Delta combinations is limited to 

Multi-Level analysis without springs. The program checks for both and 

will filter out P-Delta combinations in the analysis combination window if 

either condition is not met.   

Batch Processing: A geometric stiffness matrix is produced through an 

iterative procedure based on a master combination. This matrix is 

combined with a general stiffness matrix for solving subsequent 

combinations tagged as P-Delta and having identical load cases and 

factors with additional lateral load cases defined in the combination.  An 

example of this would be the following series of defined combinations: 

 1.0*SW + 1.0*SDL+ 1.0*LL 

 1.0*SW + 1.0*SDL + 1.0*LL + 1.0*EQX 

 1.0*SW + 1.0*SDL + 1.0*LL + 1.0*EQY 

In this example, all combinations are defined as ‘P-Delta’ in the Load 

Combination input window as shown below. Note that naming of 

combinations for ‘P-Delta’ follows the same rules as those for other 

combination types. The use of special characters should be avoided, 

underscore, space or dash can be used as separators and brackets and 

parentheses are permitted.  
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Multiple master combinations are automatically considered if they are set 

to ‘P-Delta’ and there is at least 1 additional combination that contains the 

same root set of load cases and factors.   

It is recommended and more common to define a master combination that 

includes only gravity loads or loads that will be sustained on the structure 

resulting in sustained axial forces in the vertical elements.   

Singular Processing: A geometric stiffness matrix is produced through an 

iterative procedure for each unique ‘P-Delta’ combination. This matrix is 

combined with a general stiffness matrix for the combination solution. 

This method requires a significant increase in computation time since each 

combination requires multiple iterations for convergence. An example of 

this would be the following series of defined combinations: 

 1.0*SW + 1.0*SDL + 1.0*LL + 1.0*EQX 

 1.0*SW + 1.0*SDL + 1.0*LL + 1.0*EQY 

 

2.2 P-Delta Combination Results   

Similar to other combinations defined in the model, combinations set to 

‘P-Delta’ that are solved produce general analysis results are selectable 

through use of the Result Browser.  In the ‘Loads’ tab, a new option is 

shown that lists the solved P-Delta load combinations.  If a combination is 

selected, the ‘Analysis’ tab can be used produce a graphical analysis 

result.   
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It is advised to create combinations set to NO CODE CHECK in order to 

obtain direct analysis results comparisons between 1st and 2nd-order 

effects for the same set of applied loads on the structure.  The program 

does include new Drift and Moment Amplification Factor graphical and 

tabular results.  These are discussed in Section 2.2. General frame results 

(i.e. moments, shears, displacements) reported graphically in the  

Results Browser apply only to the 2nd-order solution for combinations set 

to the ‘P-Delta’ option.   

The processing and design of both automatic and manual design sections 

for floor and beam design do not include 2nd-order effects. Combinations 

with the P-Delta tag are suppressed when designing sections.   

Oftentimes, the need arises to design columns in moment frames and other 

sway structures for the effects of P-Delta. The column design procedure in 

ADAPT-Builder is allows the user to design columns for any combination 

solved for in the program, regardless of the analysis/design option type set 

forth in Loads>Load Combinations.  

From Column Design>Column Design Settings the user can include P-

Delta combinations in the selection group if a solution for these 

combinations is available.  
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2.3 Theoretical Background 

This section summarizes the theoretical formulation and the 

implementation of PDELTA analysis using ADAPT’s FRAME finite 

element solver. 

P-Delta analysis is a methodology to compute structures which are prone 

to the load-displacement interaction, resulting in second-order effects. 

This basically means that the load which is applied to the structure is 

parametrically controlling the elastic or inelastic response of the structure. 

Such structure cannot be solved using standard (single step) linear elastic 

process [KS]*[D]=[F], but instead requires the iterative approach.  

There are two types of P-Delta methodologies: 

• Large P-Delta (P-Δ) 

• Small P-delta (P-δ) 

“Large” P-Delta (P-Δ) refers to the second order effect associated with the 

lateral translation of the members. The idea of large P-Delta (P-Δ) is 

illustrated in the following diagrams: 

 

“Small” P-delta (P-δ) refers to the second order effect associated with the 

member curvature. The idea of small P-delta (P-δ) is illustrated in the 

following diagrams: 
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The difference between these two methodologies lies in the mathematical 

formulation as well as in FE solution approach. On the level of 

mathematical formulation (which translates into FE formulation) the 

difference can rely in excluding or including higher order terms 

(geometric nonlinearity).  

On the level of a finite element (FE) solution, the difference between these 

two methodologies will also depend on the granularity of meshing as well 

as prescribed number of iterations. For refined meshes, the solutions using 

both approaches may lead to similar solutions.  

The most accurate methodology is when nonlinear 2nd-order FE analysis 

is used. In such case the effects of member curvature are covered by high-

order formulation (geometric nonlinearity), and for this reason it is a 

(small) P-delta solution.  

Linear elastic second order analysis is commonly used in engineering 

practice and allowed by design codes (e.g. ACI 318). Linear elastic 2nd-

order analysis which is based on geometric stiffness matrix is considered 

sufficiently accurate for engineering applications. 

The implementation focus in ADAPT-Builder’s frame solver is that of P-

Delta (P-Δ) 2nd-order, linear elastic, and small displacements calculations 

in conjunction of geometric stiffness matrix of frame (beam/column) 

element. 
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2.3.1 Definition of Geometric Stiffness 

A geometric stiffness matrix KG accounts for the effect of loads 

existing in the element on the stiffness of the element. For 

example, it is well known that the axial load in a beam-column has 

an appreciable effect on the lateral stiffness. The geometric 

stiffness matrix KG is an adjustment to the conventional elastic 

stiffness matrix to account for such effects.  

The adjusted (combined) stiffness matrix of the entire system is 

used in the course of finite element computation, to obtain a 

solution which incorporates the effects of load on the stiffness of 

the system. Such computational process requires iterative or a 

pseudo-iterative approach in order to converge to a solution for 

which the adjusted (combined) stiffness matrix corresponds well to 

the applied loads, and the displacements for two consecutive 

iterations are within prescribed tolerance. 

The geometric stiffness matrix can be derived for frame (beam and 

column) elements as well as for plate shell elements. The 

derivation of the geometric stiffness matrix for frame elements is 

relatively simple and straight-forward.  

The derivation of geometric stiffness for plate triangular and 

quadrilateral elements is much more complex, and it presents 

multiple mathematical and numerical challenges. The current 

implementation in ADAPT-Builder’s frame solver does not cover 

the geometric stiffness of plate shell element.  

The focus for the current implementation is on geometric stiffness 

of frame element, since it plays a prominent role, when computing 

structures supported on columns such as unbraced or partially 

braced multi-level frames and buildings. 

2.3.2 Formulation of Elastic and Geometric Stiffness for Frame 

Element  

A standard 3-dimensional (Bernoulli-Euler) frame element is 

assumed, having the following local coordinate system: 
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The elastic stiffness matrix of such a 3-dimensional frame element 

in local coordinates system can be represented by the following 

12x12 matrix: 

   

The corresponding geometric stiffness matrix of 3-dimensional 

frame element in local coordinates system can be represented by 

the following 12x12 matrix: 
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Where: 

P – axial force in the element 

L – length of the element 

I – Ix+Iy – Polar moment of inertia  

The combined elastic+geometric stiffness matrix of frame element 

as implemented in ADAPT’s Frame can be represented by the sum 

of each matrix location entry in from the matrices shown above.   

2.3.3 Description of the Solution Process 

The combined elastic and geometric stiffness matrices [Ke+Kg] of 

individual frame elements are transformed from the local to global 

coordinate system and assembled into a stiffness matrix of the 

entire system [Ks]. The results are obtained in a similar fashion by 

solving the system of finite element equations:  

 [Ks]*[D]=[F] 

Where: 

[D] – nodal displacement vector (unknown) 

[F] – nodal force (load) vector. 



 ANALYSIS AND DESIGN IMPROVEMENTS Chapter 2 

 

 

15 

Because geometric matrices [Kg] are parametrized by the axial 

forces acting in the elements, the solution needs to be calculated 

iteratively, and the elements of geometric matrices updated for 

each iteration. In the first iteration, the system is solved as a 

regular elastic model, without use of the geometric stiffness 

matrices. In the subsequent solutions, geometric matrices are 

employed. Typically, iterative processing converges quickly, 

especially when analyzing multi-level structures, where the 

magnitude of axial forces in the elements does not change 

significantly from one iteration to the other. For practical purposes 

2 or 3 iterations are sufficient to obtain a relevant solution. 

Because P-Delta analysis is a pseudo-nonlinear process, the 

solutions should normally be obtained using complete load 

combinations instead of individual load cases, since the solutions 

cannot be linearly combined. This causes the amount of time 

needed to obtain the solutions for multiple combinations to be 

more significant and computationally consumptive than when 

solving individual load cases. 

In typical engineering practice, P-Delta analysis is employed in 

conjunction with lateral analysis, when wind or earthquake loads 

are acting. The purpose is to capture the amplification of the lateral 

effects due to P-Delta effects. For such cases, literature suggests 

that simplifications are possible in the process, so as to limit the 

computation time.  For example, when the following load 

combination is involved: 

U=1.2D + 1.0L + 0.2S + 1.0E 

there are typically several variations of it, because the seismic load 

can be acting in a few different ways. Literature sources suggest 

that the amplification of lateral loads due to P-Delta effects may, in 

such situations, be obtained by evaluating the geometric stiffness 

matrices based on the vertical and sustained gravity components of 

the load combination such as: 

U=1.2D + 1.0L + 0.2S 

The assumption here is that the lateral loads have negligible effect 

on axial forces in vertical elements (columns). Under this 

assumption several combinations of the same type can be solved in 

parallel using the same iteration process. The first “master” load 

case (or vertical combination) may be solved, such as:  



Chapter 2 ANALYSIS AND DESIGN IMPROVEMENTS  

 

16 

U=1.2D + 1.0L + 0.2S 

This combination is used to evaluate the geometric matrices. The 

remaining combinations, such as all the lateral variations of:  

U=1.2D + 1.0L + 0.2S + 1.0E 

can be solved in parallel using the same set of system matrices. 

This performance improvement is implemented in FRAME as part 

of batch solutions as described later in the document. 

2.3.4 Prestressing in Conjunction with P-Delta 

There is limited information with regards to how prestressing or 

post-tensioning forces are to be handled when performing P-

DELTA analysis. The comments contained in this section are for 

the most part the opinion of the ADAPT and may not be in 

agreement with other literature sources. 

Prestressing is a source of compressive axial forces in the 

elements. Prestressing and post-tensioning tendons are embedded 

inside the element (if not external), therefore eccentricity of the 

tendon remains unchanged, with regards to the deformed section. 

Subsequently there is no amplification effect for the tendon’s 

transverse actions as a result of the compressive prestressing force. 

Similarly, there is no amplification effect when a prestressing force 

acts in conjunction with transverse loads different than PT.  An 

embedded tendon itself is not a source of buckling (secondary) 

effect for the host concrete element. 

For this reason, it is unnecessary to account for the axial force due 

to prestressing, when evaluating the elements of the geometric 

stiffness matrices. The axial forces to be used for evaluating the 

geometric stiffness matrices should primarily be based on gravity 

load components. The transverse effects of the post-tensioning 

(“load balancing” effects) may interact with the axial forces in the 

elements due to external loads, such as gravity loads, leading to the 

secondary (P-Delta) effects. In other words, the P-Delta effects are 

possible, when tendon exerts transverse load on the element in 

conjunction with external (non-PT) axial force within the element.  

The reason for this is that post-tensioning generates the 

deformation of the member, therefore an additional external axial 

force acting on the member may lead to the amplification of the 

deformation caused by the tendon. 
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Let us assume that we have the following load combination to be 

analyzed for P-Delta: 

U=1.2D + 1.0L + 0.2S + 1.0P + 1.0E 

Based on what was written before in this section, two load cases in 

this combination, prestressing “P” and lateral “E”, are the obvious 

candidates to be excluded from evaluation of the geometric 

stiffness matrices.  

The implementation of P-Delta in ADAPT-Builder’s frame solver 

automatically excludes the contribution of prestressing force from 

the calculation of geometric stiffness matrix. This takes place for 

all possible arrangements of load cases (load combinations) in the 

INP input file, both in singular and batch processing modes.   

2.3.5 P-Delta Analysis Using Load Batches 

ADAPT-Builder’s frame solver has the capability to solve multiple 

load cases in single solution handling (using the same system 

stiffness matrix). In such a case, the right-hand side of the FEM 

equation system consists of multiple nodal load vectors, and the 

solution consists of multiple vectors of nodal displacements. 

Normally these types of solutions are only possible for linear 

analysis. The advantage of this feature is a significant reduction of 

the computation time, because the system stiffness matrix needs to 

be solved only once for multiple load combinations. 

Since P-Delta is pseudo nonlinear, it is not possible to obtain fully 

accurate P-Delta solutions when using load batches. When analysis 

is performed using load batches, the first load set (partial 

combination) from the batch will be used to evaluate the combined 

stiffness matrix of the system [Ke+Kg], while the remaining load 

sets in the batch may include the load components which are 

negligible or inappropriate for calculation of the geometric 

stiffness.   

For the load combination mentioned above, the first load set 

(partial combination, or “master” combination) to be used for 

evaluating the combined stiffness matrix of the system [Ke+Kg] 

will be as follows: 

U=1.2D + 1.0L + 0.2S + 1.0P 
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In the above combination, the prestressing component will be 

ignored by the program, when evaluating geometric stiffness 

matrices, but will be considered otherwise. 

The remaining load sets for given load batch may represent the 

complete combinations such as: 

U=1.2D + 1.0L + 0.2S + 1.0P + 1.0E 

Typically, there are several variations of the lateral load “E” (or 

similarly, “W” for wind), therefore the load batch will produce 

several solutions, using single system matrix [Ke+Kg] if those 

variations are included as combinations.  

Similar multi-load solutions can be obtained when the lateral load 

is of wind type. 

The usage of batch loads required additional provisions in 

ADAPT-Builder’s GUI, in order to automate the process of 

generation of INP input file. The algorithm developed in the GUI 

allows for combinations to be set to the ‘P-Delta” analysis/design 

option type. This algorithm performs the following functions: 

1. Load Combinations will be internally sorted according to: 

 

• combination category (SLS, ULS etc) 

• type of analysis (P-DELTA included or excluded) 

• combination factors for each load component (SW, 

DL, SDL, LL, PT EQ etc) 

 

2. Load combinations which are selected for P-Delta analysis 

will be assigned into groups (batches) based on identical 

load factors for vertical (gravity) load factors. 

The group (batch) which will be solved together needs to 

have all load components and factors identical, except for 

the lateral component. 

3. For each P-Delta load combination batch, the algorithm 

creates a master combination which includes identical load 

components. This master load combination is used to 

establish the geometric matrix.   
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The algorithm for P-Delta load combination post-

processing, has the ability to switch from batch load 

solutions to individual solutions. Although the load batch 

approach is oftentimes sufficiently accurate when analyzing 

multi-floor buildings with prevailing gravity loads, it may 

sometimes be insufficient. The program gives the user an 

option to switch from batch load solutions to individual 

solutions.  

Individual solutions may be computationally more 

consuming, but sometimes can be useful for the engineer. 

The use of individual solutions is especially justified, when 

structural model is fully developed and requires final 

results. 

If P-Delta load combinations are developed such that there 

is no unique set of load cases and factors that is repeated, 

each combination is solved independently with a unique 

geometric matrix, not shared.   

2.3.6 Special Considerations  

In ADAPT-Builder’s frame solver, the computations using P-Delta 

methodology can only be performed for frame (building) 

structures. Currently the frame solver does not support P-Delta 

computations for models which are supported on uni-directional 

(compression only) springs.  The use of uni-directional springs 

requires an iterative (pseudo-nonlinear) solution, which would be 

in conflict with the iteration process for P-Delta analysis as 

currently implemented. ADAPT-Builder’s GUI performs a check 

for uni-directional springs, and if present, disables the option to run 

P-Delta analysis. In particular P-Delta analysis is disabled, when 

analyzing models in MAT or SOG modes of the program.  

The FEM analysis which includes geometric stiffness matrices 

may on occasions result in non-solvable models. This is possible 

when the magnitude of the axial loads in the columns is close to or 

above the critical buckling loads. Even if for a single column, the 

value of axial load exceeds critical, the resulting combined 

stiffness matrix [Ke+Kg] of this element may be singular and 

unsolvable. It is advisable that an engineer should perform 

preliminary static (non-P-delta) analysis first, in order to evaluate 

the magnitude of axial forces in columns, to make sure their 

critical loads are not exceeded.  Graphical reporting of 
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amplification factors for both moment and drift are available for P-

delta load combinations.  

2.3.7 Selected ACI Design Code Provisions Related to P-Delta 

Analysis 

ACI-318 code defines the requirements for structural analysis of 

concrete member design and permits the 1st order analysis with 

moment magnification, and/or, elastic second 2nd analysis. Other 

methods included are inelastic 2nd-order and non-linear FEM. 

Stability Limit 

Starting from the 2008 edition of ACI 318 code, a unified stability 

requirement was introduced on compressive members (primarily 

columns) which limits the moment amplification due to P-Delta to 

1.4 as a ratio of 2nd/1st order moments. This provision was 

presented in this edition of the code as follows: 

 

When structural model satifies this requirement for each of its 

columns, its stability is is assured both globally and locally. 

The funtionality for P-Delta analysis inside ADAPT-Builder’s 

frame solver includes new procedures for calculation of the 

following amplification factors: 

• MAF – moment amplification factors at the ends of frame 

elements. 

• DAF – drift amplification factors. 
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These values are stored in ADO output files for P-Delta solutions 

and are used as the source files for producing both graphical and 

XLS output for moment, drift and displacements.  

In the previous editions of the ACI code, the basic measure of 

stability was based on the so-called “stability index.”  ADAPT-

Builder’s frame engine does not support this particular calculation 

and stability is reported in the aformentioned method.  

Section Stiffness Reduction 

The 2008 edition of the ACI318 code sets forth the following 

requirements regarding elastic 2nd-order P-Delta analysis: 

 

In lieu of more precise determination of the properties of cracked 

sections, the following simplified stiffness reductions are 

permissible: 



Chapter 2 ANALYSIS AND DESIGN IMPROVEMENTS  

 

22 

 

The above stiffness reductions are primary prescribed for non-

prestressed members. For prestressed members ACI318 states the 

following: 

 

Assuming that structural floors and beams are prestressed, the 

reductions of stiffness included in section 10.10.4.1 are at least 

applicable to columns and walls. This means that PT structural 

models should, at the very minimum, be executed using flexural 

stiffness reduction factors equal to 0.7 for all vertical support 

elements (columns and walls). In case it is hard to determine the 

state cracking in structural walls, the more appropriate flexural 

stiffness reduction factor equals 0.35. 
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ADAPT-Builder allows users to define ‘Usage Cases’ to set 

modifiers for the structural components. A user is able to define, 

store, and obtain solutions for various usage cases. Refer to the 

ADAPT-Builder User Manuals and the ADAPT-Builder 20 

Tutorial for additional information regarding Usage Cases and 

Stiffness Modifiers.  

2.3.8 Selected EC2 Design Code Provisions Related to P-Delta 

Analysis 

Eurocode 2 Section 5.8.2 states that global 2nd-order effects may be 

ignored if they are less than 10% of the first order effects. As an 

alternative, if the slenderness (l) is less than the slenderness limit 

(llim), then second order effects may be ignored. The main 

provision for this is as follows: 

 

Essentially, this is a definition of a threshold between a non-sway 

and sway structure. 

The above limitation frees an engineer from more detailed 

slenderness design. The most adequate verification of this criterion 

can be obtained as a result of 2nd-order P-Delta analysis. 

In case the 10% limits for standard analysis are exceeded and 

second order analysis is needed, Eurocode 2 specifies the 

following general requirements: 

 

This practically stipulates, that when analysis is based on 

assumption of linear materials and geometric nonlinearity, the 

reduced stiffness approach needs to be taken, similarly to the 

requirements of ACI code. Even though the detailed requirements 

may be different, the general ideas are similar in nature. From the 

standpoint of implementation in ADAPT-Builder’s frame solver, 
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the most interesting aspect is employing the use of usage cases 

with defined stiffness modifiers following code recommendations.  

Eurocode 2 presents the provisions for 2nd-order analysis of 

individual isolated members and for entire structures (global 

analysis). With regards to the calculations performed by ADAPT-

Builder’s frame solver, provisions for isolated members are of no 

particular interest. The provisions for global analysis are of 

importance here. 

Eurocode 2 mentions the following methods of analysis of 

slenderness effects: 

 

The general method is based on non-linear analysis, including 

geometric non-linearity i.e. second order effects. The provisions 

for general method (5.8.6) stipulate that both material and 

geometrical nonlinearity should be used. In case software does not 

handle material nonlinearity, these effects need to be accounted for 

by means of stiffness reductions, as was mentioned before, and 

should be based on requirements nominal stiffness method of 

section 5.8.7. The nominal stiffness method is primarily meant for 

global analysis. The nominal curvature method (5.8.8) is primarily 

to be used for isolated members, and therefore it is not useful in 

application within ADAPT-Builder.  

The nominal stiffness method (5.8.7) presents the following 

requirements regarding calculations of stiffness reductions of 

slender elements: 
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The provisions of 5.8.7(4) are the most relevant from the 

standpoint of the implementation of P-Delta in ADAPT-Builder. 

This means that the stiffness reductions prescribed in eq. 5.27 

(which are constant factors) are sufficient to satisfy the 

requirements of the EC2 code, for typical multi-story frame 

buildings. The value of effective creep ratio ef should be 

determined based on requirements of sections 3.1.4 and 5.8.4. 

Additional requirements regarding global 2nd-order analysis are 

presented in Annex H of EC2 code. In this annex, further 

simplifications are given as follows: 



Chapter 2 ANALYSIS AND DESIGN IMPROVEMENTS  

 

26 

 

Two stiffness reduction factors are mentioned here: 

• 0.4*EcIc – for cracked elements  

• 0.8*EcIc – for uncracked elements. 

The use of these stiffness reductions is further elaborated in 

“Eurocode 2       Commentary” as follows: 

 

In conclusion, the approach of reduced stiffness presented in EC2 

is similar   to the approach in ACI code, except for detailed values 

of reduction factors. 

2.3.9 Selected CSA Design Code Provisions Related to P-Delta 

Analysis  

The Canadian design code (CSA) is similar to ACI code with 

regards to 2nd-order effects. 

The values of stiffness reduction factors to be used in conjunction 

with P-Delta analysis are as follows: 



 ANALYSIS AND DESIGN IMPROVEMENTS Chapter 2 

 

 

27 

 

CSA code imposes the following limitation of displacement 

amplification factors (DAF): 

 

These limitations are reported graphically and in XLS format 

within ADAPT-Builder’s GUI for all design codes where P-Delta 

is used.  

2.3.10 Selected NBR Design Code Provisions Related to P-Delta 

Analysis  

Brazilian code defines non-sway and sway frames in a similar way 

to EC2, as follows: 
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The following stiffness reduction factors are adopted for the 

purpose of elastic, 2nd-order analysis: 

     

2.3.11 Selected AS-3600 Code Provisions Related to P-Delta Analysis  

Australian code AS-3600 presents the following requirements 

regarding 2nd-order P-Delta analysis: 

 

Stiffness reduction factors for this code are similar to EC2. 

2.3.12 Design Codes – P-Delta Summary 

In summary, based on the above, when performing global 2nd-order 

analysis based on ACI or EC2, NBR, AS-3600, it is permissible to 

account for material nonlinearity (cracking, creep etc) using 
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simplified stiffness reduction factors. The basic reduction factors 

for non-prestressed elements are as follows: 

 

ADAPT-Builder gives the user the capability of defining 

customized, user-imposed “Usage Cases” where stiffness 

modifiers are introduced and imposed at a component level.   

While some design codes don’t impose an explicit limitation on the 

amplification factors obtained in the course of P-Delta analysis 

(stability limit), ADAPT-Builder reports a ratio of 2nd/1st order 

drifts and moments.  The default limit in ADAPT-Builder is set to 

1.4 but can be modified by the user. The program checks this and 

graphically reports the outcome.  XLS data is also presented for 

drift results.  

2.4 Drift and Moment Amplification Factors 

2.4.1 Introduction 

With the new P-Delta feature, the program graphically reports drift 

and moment amplification factors (2nd/1st order results) for local 

axes (RR and SS) as well as the combined global results. The 

program code checks against a user-defined value set in the Result 

Browser.  The default value is described in the section above.   

Some design codes require an explicit limitation on drift 

amplification for the purpose of ensuring a stability limit.  The 

following sections describe how the drift and moment 

amplification factors (DAF and MAF) are used. The prerequisite to 

these results is to have completed a global FEM solution with the 

presence of P-Delta combinations included.   
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2.4.2 Graphical Drift Amplification 

To invoke the graphical drift amplification values and code check, 

the user must select a P-Delta combination result in the ‘Results 

Browser’ as shown below.  Note that selection of the master P-

Delta combination is usually not required or typical for drift 

amplification since it serves only as the driver for the geometric 

stiffness generation.  

 

Once the combination has been selected, the ‘Analysis’ tab can be 

used to produce the result.  Select Column→Drift and the 

amplification factor options are selectable for Combined, X, or Y 

directions.  Once selected the program will produce a Green or Red 

colored column to indicate if the value is less than or greater/equal 

than the user-defined value.  This value is set to 1.4 by default.  

The user can change this setting in the ‘Display’ tab from the 

Result Browser.   
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The image belows shows the code check for the combined drift 

amplificaton factors at the top level of a structure. Note the legend 

in the upper corner of the window reports the result, combination 

and type, allowable value and the max/min values.   

 

To produce this result, the program calculates the drift for both the 

1st and 2nd order results.  Drift is taken as the differential 

displacement from the top node of the upper frame element of the 

column to the bottom node of the bottom frame element of the 

column, divided by story height.  The ratio is then taken between 

the calculated drifts for 2nd to 1st order results.  Note that if a 

situation is modeled where multiple columns extend over multiple 

floors and don’t connect to slabs at each column break-point, the 
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drift is still reported per column and the height used is that between 

the top and bottom of column. 

Displacements used for the drift calculations are those relative to 

the result selection made: X, Y or combined.  For combined the 

program uses the global displacements. 

2.4.3 Graphical Moment Amplification 

To invoke the graphical moment amplification values and code 

check, the user must select a P-Delta combination result in the 

‘Results Browser’ as shown below.  Note that selection of the 

master P-Delta combination is usually not required or typical for 

moment amplification since it serves only as the driver for the 

geometric stiffness generation.  

 

Once the combination has been selected, the ‘Analysis’ tab can be 

used to produce the result.  Select Column→Action 

(Combination)→Moment Amplification Factor about rr or ss.  The 

amplification factor options are selectable for moments about rr or 

ss local axes for columns.  Once selected the program will produce 

a Green or Red colored column to indicate if the value is less than 

or greater/equal than the user-defined value.  This value is set to 

1.4.  The user can change this setting in the ‘Display’ tab from the 

Result Browser.   
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The image belows shows the code check for the moment 

amplificaton factor about the local rr axss at the top level of a 

structure. Note the legend in the upper corner of the window 

reports the result, combination and type, allowable value and the 

max/min values.   

 

To produce this result, the program calculates the moments at the 

top and bottom of columns for both the 1st and 2nd order results. 

The ratio is then calculated for the top and bottom locations for 2nd 
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to 1st order results. The maximum ratio is reported and checked 

against allowable.  

2.5 Effective Flange for Beam Design in ADAPT-Builder 

2.5.1 Introduction 

The program now includes the option to calculate the effective 

flange and properties of beams when the support line is set to 

‘Beam’ criteria.  The design of the beam sections is performed 

using the effective properties.  The component of stress related to 

the precompression uses the full tributary area of the section as 

does the graphical precompression result.  ACI and EC2 

calculations for effective width are supported.  

2.5.2 Methodology 

The program includes effective flange formulation for two design 

codes:  ACI318-14 and EC2.  All design codes will default to the 

ACI methodology expect for EC2 and NBR codes. The user can 

also manually generate splitters or use max tributary offset input 

for the design strip to create user-defined flange widths.   

The implementation for ACI uses the following expressions from 

ACI318-14 Section 6.3.2, excluding point (c).   

 

The implementation for EC2 uses the following expressions from 

EN 1992-1-1:2004 Section 5.3.2.1 (3).  
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2.5.3 Defining the Effective Flange Option in a Model 

When the effective flange option is used, the program uses 

effective properties in performing the following calculations: 

• Calculation of reinforcement for minimum and strength 

requirements of the design section 

• Calculation of flexural stresses for PT design sections.  

That component of the stress calculation, My/I, is based on 

the centroid of the effective section and moment of inertia 

of the effective section.  That component of the stress 

calculation, P/A, uses the area based on the full design 

section as modeled for the design strip. Note that the P/A as 

reported graphically is based on the full tributary area, not 

the effective area.   

Actions for the design of effective sections are those as calculated 

per the Nodal Integration Method (see ADAPT-Technical Note 

TN302 – Design Section Values) over the full tributary width of 

the design section.   

To define use of the effective flange in the ADAPT model, use the 

following sequence of instructions: 

1. Set the support line to the ‘Beam’ design type from double-

clicking on the support line, selecting ‘Design’ and set the 

criteria to ‘Beam.’   
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2. Set the ‘Design Section Options’ for the support line.  

Use the options in ‘Design Width Limits’ to enable the 

option for effective flange. Two additional options are 

shown for exlusion of tendons and rebar outside of the 

effective flange.  If these options are selected, the 

program will ignore the area of prestressing or 

reinforcement that fall within the the modeled tributary 

but outside effective flange, for calculation of 

reinforcement for the design section.  
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3. Select the green checkbox at the top left corner of the 

Support Line property box. 

 

4. Generate the design sections from Floor 

Design→Generate Design Sections.  Note for the image 

below the generated design strip is taken as the full 

tributary of 13.5 ft (162 in).  The design actions at the 

centroid of the design section is based on nodal 

integration of the actions over the full width of the 

generated design strip.  
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The image below shows the properties of a design section with 

consideration of effective flange properties.  While the generated 

design strip width is 162in., the effective flange width as used in 

the calculation of reinforcement and flexural stress is taken and 

calculated as 122.9in. 

The window below shows two images.  The first is the physical 

section cut and the second is the idealized section cut which uses 

the effective flange. 

Use of full design strip 

width for calculation of 

deign actions 
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2.6 Punching shear for Aci 318-14  

2.6.1 Introduction 

New improvements have been made for punching shear checks in 

ADAPT-Builder according to ACI318-14.  The first improvement 

is the option to consider the least critical section as an octagonally-

shaped section at a distance of d/2 outside the last line of 

reinforcement.  The applicable code sections being 22.6.4.2 and 

22.6.6.1.   

The second improvement is the option to consider minimum 

reinforcement up to a distance 4*slab thickness to satisfy a 

minimum strength of 3.5*f’c^1/2.  This requirement is found is 

Section 18.14.5.1 and is applied to satisfy adequate ductility of 

members not part of a lateral-resisting system in seismic design 

categories D, E, and F.   

The program provides the user the option to consider the preceding 

two features from Floor Design→Shear Options. The options can 

be considered in tandem (as shown below) or separate.   
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The third improvement applies to the application of minimum 

reinforcement at critical sections as dictated in ACI318-14 Section 

22.6.8.3. The critical section used to determine the minimum 

amount of reinforcement is that of the section located d/2 from 

face of support.  In previous versions of the software, the critical 

section length as based on the section being checked.  In other 

words, the amount of reinforcement necessary to meet minimum 

became larger each critical section (layer) that was checked.  Upon 

a formal review of the program source code and the interpretation 

of design code, this was modified and improved.   

The following sections provide more detailed description of the 

first two features described above.   

2.6.2  Critical Section Outside the Reinforced Zone 

The option to consider critical sections outside the shear reinforced 

zone with either a rectilinear or octagonal-shaped critical section is 

given in the program. ACI318-14 Sections 22.6.4.2, 22.6.6.1 

apply.  The following images show the octagonal-shaped section 

introduced in ADAPT-Builder 2019 for compliance with ACI318-

14.  Note this section shape can now also be used for designs 

performed using all ACI318 versions supported by the program.  
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When this option is selected the program determines the critical 

section, based on a rectilinear shape, where no reinforcement is 

required. Each critical section is located at d/2 from the previous. 

At the critical section where no reinforcement is required (As = 0), 

the program rechecks the same location but with a reduced critical 

length and area. This is calculated using an octagonally-shaped 

section and is checked until the stress is less than code specified. 

The user can specify the edge distance between the edge of column 

and stud rail or shear stirrups. This value affects the critical section 

length.  
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The location where at which the octagonally-shaped critical section 

begins being checks is evident in the XLS output for punching 

shear in ADAPT-Builder.  This can be viewed from 

Reports→Punching Shear→XLS Reports→Punching Shear 

Report.  There are two sheets within this report that dictate the 

location the of the section shape change.  These include the 

‘Critical Section Geometry’ and the ‘As Required’ sheets. An 

example is presented below for an interior column located at Grid 

D-2.  The first image is a graphical indication that this column 

requires reinforcement.  Continuing into the details of the XLS 

report, the 2nd image below shows the location at which the critical 

section area reduces. Note between critical sections 1 and 5 the 

area increases.  Between sections 5 and 6 there is a decrease in area 

from 1424.8in2 to 1226.9in2.  This indicates that section 6 is the 

first section checked as an octagonal section.  Additional sections 

(8-14) are required to be checked with the same shape.  
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The image below shows the required area of steel for the same 

column at Grid D-2.  Note that at critical section 5, where the 

rectilinear shape is used, the required As is calculated as zero.  The 

next critical section and all remaining in sequence are those 

checked for the octagonally-shaped section.   

The user can also review the ‘Stress Check’ sheet to review the 

allowable stress reported and there is clear indication given where 

the maximum stress of ϕ*2*f’c^1/2 is reported. See table 22.6.6.1 

for reference.  

 

2.6.3 Minimum Reinforcement for Drift  

The option to apply two-way shear provisions for minimum 

reinforcement for seismic drift as found in ACI318-14 Section 

18.14.5.1 is now included in ADAPT-Builder. The referenced 

provision is found in the excerpt below.  Note that the provision is 

conditional upon a check of the interstory drift ratio at the support 

location.  However, the program does not check this but gives the 

user the option to directly enforce the minimum shear strength as 

given as 3.5*f’c^1/2.           
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The current expresssions used to calculate As for two-way shear is 

shown below as taken from ADAPT-Technical Note TN504.  If 

the new minimum reinforcement for drift requirement is selected, 

the program checks that the quantity in the parentheses is ≥ 

3.5*f’c^1/2 for all critical sections with a distance 4*slab thickness 

from face of the support.  Additional checks with respect to 

Av,min still apply as shown below.   

 

2.7 FELT 3D and Long-Term Losses  

2.7.1 Introduction 

When the PT Shop Drawing module is enabled in the splash screen 

of ADAPT-Builder 2019, the program enables new input and 
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functionality for the calculation of long-term losses for unbonded 

tendons and bonded tendons stressed at the same time.   

Explicit calculation of long-term losses related to elastic 

shortening, creep, relaxation, and shrinkage can now be performed 

for all modeled tendons in ADAPT-Builder. This can be performed 

in addition to friction loss and elongation calculations.  The 

program retains the ability to enter lump-sum long-term loss 

estimates as an alternate method. Detailed loss calculation 

examples and background can be found in ADAPT-Technical Note 

TN-T9-04-Prestresssing Losses and Elongation Calculations.   

The program provides detailed tabular and graphical report data for 

FELT 3D. The reporting options are located in a later section of 

this document.    

Additional features have been added to a new Drawing Editor.  

This option is also invoked when the user enables the PT Shop/3D 

FELT module in the program splash screen. The option can be 

found from Tendons→Shop Drawing→Drawing Editor. The 

information below provides more detail about each of these 

features including a new tendon shape for modeling and 

representation of tendons with in-plane sweep.   

2.7.2 Setting Options for Long-Term Loss Calculations   

The option to calculate long-term losses for modeled tendons can 

be set individually or by selecting a group of tendons. Remember 

that unless the option for the PT Shop/3D Felt is enabled, long-

term losses can only be entered as lump sum values.   

Individual Tendon: Double-click on a tendon to open the Tendon 

Properties dialog. In the ‘Stressing’ tab the option checked for 

‘Calculate force’ will enable the long-term loss options. Selecting 

‘Calculate long-term loss’ will enable the user to input the long-

term loss parameters as shown in the image below.  
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Multiple Tendons: Select a group of tendons and go to 

Modify→Modify Item Properties→Tendon. In the ‘Stressing’ tab 

select Calculated→Long-Term Stress→Calculated→Properties. 

This will enable the user to input the long-term loss parameters as 

shown in the image below and apply these to the selected group of 

tendons.  
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2.7.3 Drawing Editor  

To invoke the Drawing Editor, select the icon shown below from 

Tendon→Shop Drawing.  

  

The Shop Drawing Editor contains 3 primary tabs as shown below:  

Tools, Chair Groups, and Colors.   

 

Tools – This option allows the user to convert the all tendons from 

straight or spline representation to fillet-radius representation.  

This is described in section 2.5.4.  The user can also remove non-

auto swerve points for tendons set to spline mode using this option.  

By selecting ‘Apply’ the program will remove the points for all 

tendons set to spline meeting this condition.   

Chair Groups – This option allows the user to input on-demand 

chair bar maximum spacing and chair bar extensions for graphical 

output of tendon support bars and chair heights.  To remove the 

bars and chair heights, use the ‘Clear’ option and select the desired 

tendons.   
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In the 2nd image below, max bar spacing is set to 48” with the bar 

extension each side set to 8 inches.  The example shows distributed 

tendons. Where the support bars overlap, the bars are represented 

as continuous with the applicable chair height.   

  

 

Colors – This option provides input for grouping tendons into 

user-defined colors and defining tendon labels per the color group 

assigned to the tendon. The program combines tendons of the same 

installation length into groups for based on the user-defined colors.  

New graphical tendon properties related to colors, groups, labels 

and lengths can be found from Tendon→Display Manager.   
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2.7.4 Tendon Shape – Fillet-Radius    

The program now includes the option to geometrically and 

analytically represent the tendon as ‘Fillet-Radius’ input.  This 

combines straight tendon segments with curves represented as 

fillets based on user-input for the radius. The option allows the 

user to control in-plane deviation at control points without auto-

correction of adjacent spans similar to how spline tendons are 

treated.   

Individual Tendon: Double-click on a tendon to open the Tendon 

Properties dialog. In the ‘General’ select the ‘Fillet’ option and 

input the radius from the ‘Mode’ selections.  The radius is 

measured from the an origin of the control point that has been 

deviated in-plane.    

 

Multiple Tendons: Select a group of tendons and go to 

Tendon→Tendon Editor.  This will open the Dynamic Tendon 
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Editor.  In this dialog window select the ‘Mode’ tab to change to 

the Fillet option. This will apply this mode to all selected tendons.  
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3. MODELING IMPROVEMENTS 

3.1 Strip Modeling – Dynamic Editor 

A new and Strip Modeling Dynamic Editor includes tools used to more 

rapidly model and modify support lines and design strips. This new tool is 

found at Floor Design→Strip Modeling. Manual creation of support lines 

is still available in v2019 as it has been done in previous versions through 

use of the Create X and Create Y Support Line tools.   

 

The image below shows the Dynamic Editor dialog window.  Note the 

option is given to ‘Pause’ or ‘Resume.’  This allows the user to keep the 

window open and work in the main User Interface if needed.   

 

Tools included are in the Dynamic Editor are described below.  
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• Support Line Wizard – Creates a support based on a construction 

line defined by snap points along the strip path. Rules included in 

placement of construction line vertices include: 

 

1. The first snap point defines the start point (vertices) of the 

support line. 

 

2. Select ENTER or right-click and select Close/End/Accept 

to complete the construction line.   

 

3. Upon completion of a construction line, the program works 

in continue mode and the next snap dictates the start of the 

next construction line.  This happens until the use exits the 

Dynamic Editor or moves to a different tool tab in the 

window.   

 

4. Beginning and end construction line snap points that start 

or terminate outside of a slab edge will be auto-trimmed 

back to the slab edge.  

 

5. Snap points are not required to click on the centroid of a 

column for the program to create a vertex at that point.  The 

construction line only be required to pass through a 

column.   

 

6. The construction line can pass through multiple columns in 

a single segment of the construction line. A construction 

line vertex allows the construction line to change direction. 

In the image below the construction line begins at point 1 

and passes through the first column. The segment between 

points 2 and 3 also pass through the 2nd column.  In both 

cases, because the segments intersect the column, the 

program places support line vertex at these support 

locations. The 2nd image below shows the created support 

line.   

 

7. The construction line vertices should snap near end-points 

of the wall for the auto-generation of support line nodes at 

the wall ends.  The first image below shows the points 

placed near wall end and the outcome includes the nodes at 

the wall endpoints.   
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8. If the construction line vertex snaps in the middle half of a 

wall, only a single node is added at that snap point.  

 

 

9. If the construction line does not snap on a wall at any 

location, no vertices are added to the wall.  
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10. For walls oriented perpendicular to a support line or at an 

angle < 45° relative to a line perpendicular to the support 

line, it is common to snap a single point at the wall so as to 

create a “span” where the wall is at the start/end of adjacent 

spans. See the images below.  Note the same rule applies if 

the snap point is near the wall end, the program places the 

support line node at the wall endpoint.  

 

 

11. Placement of construction line snap points are similar to 

walls.  If the snap point is near the end of a beam, the 

program places the support line nodes at the beam 

endpoints.  In addition the program isolates the support line 

over the beam and changes the design criteria to ‘Beam’ 

criteria.  
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12. For beams oriented perpendicular to a support line or at an 

angle < 45° relative to a line perpendicular to the support 

line, it is common to snap a single point at the beam so as 

to create a “span” where the beam is at the start/end of 

adjacent spans.  Note the same rule applies if the snap point 

is near the beam end, the program places the support line 

node at the beam endpoint.  

 

13. The start and end span of a support line created from the 

wizard follow the same path as the construction line.  

Therefore, the user may need to re-align the endpoints of 

the support lines to maintain perpendicularity to the slab 

edges.   

 

• Support Line Limits – Changes selected support line design 

criteria and tributary limits for the design strip. When this tab is 

selected, the current design criteria and limits will be displayed on 

all support lines. Set the desired criteria and snap or window 

support lines to modify to the desired setting.   
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The option to change Tributary Limits allows a user to set the 

maximum tributary width for a design strip.  If ‘None’ is selected, 

the program’s algorithm will determine the tributary with 

proximity to adjacent support lines.  The image below shows the 

outcome of the limit set to none for a partial length support line.   

Let us assume we want to limit the tributary to 5’ each side and we 

input this as the limit and regenerate the strips.  The 2nd image 

below displays the outcome.  Note that the tributary extents of the 

design strips above and below don’t change.  To extend these strips 

to the limited tributary, splitters can be added.  See the 3rd and 4th 

images below.   

Options for tributary limits can also be modified per support line 

by double-clicking the support line and using ‘Design Section 

Options.’   
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• Wall – This tool allows the user to set boundary conditions for 

how walls are considered for design strip tributary generation.  The 

default conditions are set to automatically consider walls as X and 

Y boundaries.  Options are given for the user to manually define 

how walls are treated.  Select ‘User Def’ and select the boundary 

option and then click on the wall to set the boundary.  User-defined 
boundaries remain until the option is set back to ‘Auto’ or until the 

manual boundary is set to another option.  The link below contains 

an instructional video that illustrates more detailed use of wall 

boundaries.  

https://www.youtube.com/watch?v=vbY5_tec9vo 

https://www.youtube.com/watch?v=vbY5_tec9vo
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• Display- Sets the support line display for Direction, Criteria and 

Width Limit per the selection of checkboxes.  The ‘Update 

Drawing’ is used to reflect the current selections and label support 

lines with those selections.  The 2nd image below gives and 

example of how the information is presented on a support line.  
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3.2 Splitter functionality 

The use of splitters has been simplified in the 2019 version.  In earlier 

versions of the software, the splitter was used to create a virtualized 

boundary for termination of a tributary region for the design strip.  

Oftentimes, splitters were required when a support line start and/or end 

point was located within the perimeter of the slab region.  Other cases 

where splitters were required were limiting tributaries extending through 

or into openings, support line nodes that shared a common point and one 

support line was continuous while the other was discontinuous to the 

shared node.   

Splitters were also used to manual generate a boundary that resulted in an 

uneven distribution of tributary between two adjacent support lines.  In the 

first image below, without use of a splitter, the program generates an even 

distribution of tributary to Support Lines 3,4 and 5.  The bay length is 33’ 

between columns in the Y-direction, therefore the distribution is 16.5’ as 

shown.  If a splitter is added 8.25’ above Support Line 4, the program 

treats this as a delimiting boundary for the program-generated design 

strips.  The outcome is shown in the 3rd image below.  
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New splitter functionality in ADAPT-Builder is approached in a similar 

manner.  Splitters are only required to limited the tributary width of a strip 

in the direction of the splitter and over the splitter length. In other words, 

splitters can be used to create a boundary that the tributary edge extends 

when the width is required to be limited to either side of a support line. 

Splitters are no longer required for any other purpose as the program has 

been improved to recognize support line nodes at any location and 

properly generate strips. Below are a few other cases and descriptions of 

new splitter use.  

3.2.1 Splitters at Openings 

The X-splitters below were added to the side of an opening to limit 

the tributary from extending into the opening.  

 

3.2.2 Splitters at Slab Regions Between Openings 

The X-splitters below were added to both sides of the support line 

between the openings so as to limit the section cuts extending into 

the opening.   
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3.2.3 Splitters at Slab or Pit Steps 

With the new P-Delta feature, the program graphically reports drift 

and moment amplification factors (2nd/1st order results) for local 

axes (RR and SS) as well as the combined 

3.2.4 Splitters at beams  

Splitters were added to each side of the beam below to limit the 

beam flange tributary. This version of the program also includes 

the option to use the effective flange and properties.  If the 

calculated effective flange to either side is less than the modeled 

flange (with use of the splitters), the program will use the effective 

flange in section calculations, otherwise the “physical” tributary 

and associated properties is used.  See Section 2.3 for more 

information regarding effective flange.   
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3.2.5 Splitters at walls 

Section 3.1 defined the use of a new wall boundary conditions 

feature. This feature is intended to automatically created 

boundaries for which a design strip tributary extends to near walls.  

The use of the boundary condition feature is not required.  The 

user can impose splitters near walls to also manually generate a 

boundary where the tributary terminates.  

In the 1st image below there are walls 1 and 2.  Note that the 

support line in the view is located over wall 2.  It is typical for the 

support line to extend over wall that is oriented in the same 

direction as the wall is a support for the slab.  Wall 1 does not have 

a support line along its path.  Therefore, it is often desirable to 

extend to the design cuts only to the face of the wall. If a design 

cut extends over a wall by any length, the program only designs 

the sections for minimum reinforcement and does not produce a 

graphical stress result when the wall is part of a two-way slab.  The 

2nd image below shows the inclusion of splitters and tributary 

outcome.  
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The link below contains instructional videos that illustrate more 

detailed use of splitters. 

https://www.youtube.com/watch?v=GZpvL0r5s-I 

https://www.youtube.com/watch?v=moznFUczO3Y 

https://www.youtube.com/watch?v=GZpvL0r5s-I
https://www.youtube.com/watch?v=moznFUczO3Y
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3.3  Ramping 

Modeling of ramps is now supported in ADAPT-Builder.  Ramps are 

considered as other analytical components and meshed and utilized FEM 

solutions. Longitudinal and transverse beams can be modeled at ramps 

with options to automatically offset the beams as well as offset walls and 

columns supporting ramps. Ramps are required to be modeled in the same 

plane and the program constrains the graphical input as 3-point input to 

enforce planar modeling.  Note that the program meshes the ramp as part 

of pre-processing when the user Analyzes the model.  Meshing of slabs 

using Analysis→Meshing continues to only mesh slabs prior to the 

analysis.  The mesh of ramps and walls is similar in that they are both 

meshed as part of the general analysis algorithm.   

Limitations of ramps in the software include no tendon modeling at ramps, 

no consideration of ramp elements in the generation of design sections, no 

design of ramps utilizing design strips and sections, automated or manual.  

A user can model and offset tendons for beams supporting ramps in the 

transverse direction.   

3.3.1 Modeling Ramps 

The function used to model ramps is located from 

Model→Structural Components. When selecting this option, the 

program will prompt the user to enter the ramp corners.  Note that 

the 1st and 2nd ramp corners define the start of the ramp.  The 3rd 

and 4th corners represent the end (bottom) of the ramp. Note after 

the 3rd point is selected, the ramp construction line will be locked 

orthogonally so as to ensure the ramp is planar and not warped.   

 

In the image below, the first 3 points are input and the ramp outline 

is shown in orange color.  the start of the ramp is at the left edge 

and the end of the ramp is at the right edge.  The 2nd image below 

shows a 3d view of the modeled ramp. The slabs shown in the 

image wrap around the ramp, however, if the slab is located over 

the ramp, model an opening in the same space. 
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Ramps can be copied or moved vertically in a multistory structure 

through use of Modify→Copy/Move→Vertical. Applying this to 

the same model, a second ramp is added to the level above as 

shown below. The user can modify any of the 4 vertices that define 

a ramp. Upon selecting a point, the ramp entity will auto-adjust so 

as to maintain the planarity of the surface.   

The start and end of a ramp always references a modeled story or 

plane. If there is a need for the user to model a twisting ramp or 

ramps at different slopes within the same level, the user is required 

to created as many planes allow for a multi-sloped or multi-

segmented ramp.   
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3.3.2 Offsetting Connected Components 

Connected components like beams transverse to the ramp 

direction, oriented in the same direction as the ramp, or columns 

located at the edge of a ramp can be automatically offset and 

aligned with the ramp at their modeled position.  To do this, use 

the tool found from Model→Preprocessing→Connect with Ramp. 

The component/s required to be offset should be selected first and 

then use the tool.   

 

In the image below columns and several beams are selected.  By 

default, the offset of the top and bottom (for columns) and start and 

end (for beams) is set to zero. When using the ‘Connect with 
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Ramp’ tool, the offsets are adjusted to connect the components 

with the ramp as shown in the 2nd image.   

 

 

3.3.3  Viewing Options for Ramps 

By default, ramps are shown in Top View when modeled.  From 

Home→Zoom/Camera, any other 2D view will show the ramp. If 
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the views ‘Top-Front-Right’ or ‘Top-Back-Side’ are invoked, the 

program will present the following warning.  

 

Selecting ‘Yes’ will continue to the selected 3D view. The user can 

invoke the rendered view, referenced in the warning, from 

Visibility→Render Model.  The 3D rendered view is shown below 

with the modeled ramp.   

 

Other tools used for viewing ramps include: 

Model→Isolate→Show Ramp Components:  Isolates the 

graphical view to show only ramps in the model. Use 

Visibility→Default Display, Visibility→View Settings, or 

Model→Visibility to restore the view of other components.   

Visibility→View Settings→Structural Components: This 

displays On/Off the ramps in the model view.  
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Model→Visibility→Ramps:  This displays On/Off the ramps in 

the model view.   

3.3.4 Design Strips and Splitters near Ramps 

The current implementation of ramps in ADAPT-Builder does not 

include the design of sections cutting through ramps.  In other 

words, while a physical design cut may intersect a ramp, the ramp 

itself and associated offsets are not included in the idealized design 

section that the program processes for design of floor sections.  

It is recommended to model design strip such that the design cuts 

do not extend into ramp regions. This will aid the user in avoiding 

confusion and clearly demarking that portion of the slab that the 

program properly handles for design.  The image below shows an 

example of ramps at the top-center and bottom-center of the slab 

region.  In this example, the support lines are modeled to the start 

and end edge of the ramp.  Note the program treats the long, 

interior edges of the ramp as a boundary and the design strip does 

not extend into the ramp.  The user can also add splitters to limit an 

outcome where a tributary extends into the ramp space.   

 

In the image shown below, notice the support line was modified to 

extend continous through the ramp.  This being improper and non-

recommended input leads to a tributary portion including ½ of the 

ramp.  In this scenario, even if a tributary is created in this ramp 
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space, when the design sections are generated and design for this 

strip, the sections in the ramp are automatically removed.   

 

3.4 Beam End Offsets 

Beam coordinate definitions now include the ability to create offsets at the 

beam start and end points.  This was a necessary improvement to support 

inclined beams at edges of ramps.  Beams not associated with ramps can 

also be offset with different values at each end.  Double-click on a beam to 

open the beam properties and use the ‘Location’ tab to enter the offset.  If 

the option ‘Connect Ramp’ is selected, different offsets can be modeled.  

If this button is not selected, the program will use the same offset at both 

ends.  
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4. REPORTING IMPROVEMENTS 

4.1 Graphical Longitudinal Reinforcement on Design Strips  

The Result Browser includes new graphical reporting options for design 

sections reporting the area of steel for provided and required 

reinforcement per program calculation and base (user-defined) 

reinforcement.  In addition, the value of ‘rho’ is reported as the total area 

of steel (base + provided) divided by the section area.   

These new options are available after the design of sections has been 

completed from Floor Design→Section Design→Design/Investigate the 

Sections.  Note if the option to ‘Investigate’ is used, the ‘Calculated’ 

options below will report zero on design strips as these are intended for 

the ‘Design’ option.  These options shown below are found in the 

‘Analysis’ tab of the Results Browser from Design Sections-

Reinforcement (longitudinal).   

 

4.1.1 Calculated (required) 

Selecting this option will report the total reinforcement required as 

calculated rebar at the top and bottom of the design sections.  The 

graphical presentation is shown for the combination or Envelope 

selected from ‘Loads’ tab in the Results Browser.  It is not required 

to produce the rebar plan prior to selecting this option.  

The image below shows a presentation of the output.  The green 

graph reports the required top reinforcement and the blue graph 

reports the required bottom reinforcement. The values are shown in 

in2 and mm2 as defaults, depending on the selected unit system. 
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4.1.2 Calculated (provided) 

Selecting this option will report the total reinforcement provided as 

calculated rebar at the top and bottom of the design sections.  This 

is a function of the user-defined bar sizes for the system criteria 

type for top and bottom longitudinal bars. These options can be 

defined from Criteria→Rebar Size/Material.  The graphical 

presentation is shown for the combination or Envelope selected 

from ‘Loads’ tab in the Results Browser.  It is required to produce 

the rebar plan prior to selecting this option. If the rebar plan for the 

selected Load Combination or envelope type has not been 

produced, a warning will appear as shown below. 

 

The rebar plan is produced from Floor 

Design→Rebar→Calculated Rebar Plan or from 

Rebar→Generate→Calculated Rebar Plan.  

The image below shows a presentation of the output.  The green 

graph reports the provided top reinforcement and the blue graph 

reports the provided bottom reinforcement. The values are shown 

in in2 and mm2 as defaults, depending on the selected unit system. 
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4.1.3 Base 

Selecting this option will report the total base (user-defined) 

reinforcement modeled in the slab and/or beam at the top and 

bottom of the design sections.  The user must Design or Investigate 

the sections prior to producing the result. The graphical 

presentation is shown for the combination or Envelope selected 

from ‘Loads’ tab in the Results Browser.   

The image below shows a presentation of the output.  Both top and 

bottom graphs are reported as orange. The values are shown in in2 

and mm2 as defaults, depending on the selected unit system. 
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4.1.4 Rho 

Selecting this option will report total area of base rebar plus 

calculated required rebar for the selected load combination, 

divided by the total area of the design section.  Prestressing steel 

area is not included in this calculation. The user must Design or 

Investigate the sections prior to producing the result. The graphical 

presentation is shown for the combination or Envelope selected 

from ‘Loads’ tab in the Results Browser.  The value presented is 

shown as %.   

 

4.2  XLS File Reporting for Drift Results  

The program now includes the option to produce a .XLS report with 

multiple data sheets for lateral drift results.  These results can include or 

exclude P-Delta combinations or only 1st order lateral results.  The new 

reporting feature is invoked from Reports→Analysis Data→XLS 

Reports→Drift Report.  Prerequisite to producing the report, the model 

should be run in Multi-Level mode and contain at least a single 

combination with lateral loads included, although this is not required.   

When you select the option to produce the drift report, the following 

dialog window will appear, allowing the user to customize the report. This 

dialog includes a list of design combinations for which a global FEM 

solution has been generated.  The user can custom-select which 

combination/s to produce the report for.  
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In addition, the user can enter the allowable drift % as well as the P-Delta 

Maximum Drift Amplification Factor to check against. Note that the 

allowable drift is that entered by the user.  It is the users responsibility to 

apply any displacement amplification factor (Cd) within the value 

entered as allowable. Note these two inputs within this dialog are 

separate and do not affect those located in the ‘Settings’ tab of the Result 

Browser, which are intended for graphical code check of drift and 

amplification due to P-Delta.   

The user can also select which direction to produce the report for.  Options 

include global X and Y as well as the combined drift.   

 

Upon selection OK, the program will produce a message showing the path 

location ot the XLS file and prompt the user to open the file automatically. 

The file will open to the default application compatible with XLS files.  

This is typically Microsoft Excel® or other equivalent application.   
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The XLS file will generate 7 unique sheets of data.  These include 

Stations, Displacements, Drift at Columns, Average Drift, Max Drift 

Envelope, Average Drift Envelope, and Drift Amplification Factor.  Each 

sheet is described briefly below with an illustrative example.   

4.2.1 Stations 

This report sheet lists all columns in the model starting at the 

upper-most plane and working down.  The column label, global 

coordinates and height are shown.  

 

4.2.2 Displacements 

This report sheet shows the displacements for all columns at the 

selected coordinates for the top and bottom location of the column.  

The selected combinations for the produces results are listed along 

with the combination analysis/design option type.  The columns 

are reported by plane listed top-down.   
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4.2.3 Drift at Columns  

This report shows the inter-story drift values (in or mm) for each 

column, at each plane for the selected combinations and directions. 

The combination analysis design/design option type is listed. 

 

Additional results shown on this sheet are for code check against 

the maximum allowable drift %. The % drift for the selected 

directions are shown as well as the allowable %. If any of the 

direction values (X, Y or combined) exceed the allowable the 

program will flag this row (indicating a single column for a single 

load combination result) as NG.  If the values are less than 

allowable the row will be flagged as OK.  
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4.2.4 Average Drift 

This report shows the average inter-story drift values (in or mm) 

for all columns at a plane and for each selected combination and 

direction. The combination analysis design/design option type is 

listed. To produce the values, the program sums the drift for all 

columns and divides by the number of columns.  This is done for 

each direction and combination.   

 

Additional results shown on this sheet are for code check against 

the maximum allowable drift %. The % drift for the selected 

directions are shown as well as the allowable %. If  any of the 

direction values (X, Y or combined) exceed the allowable the 

program will flag this row (indicating a single column for a single 

load combination result) as NG. If the values are less than 

allowable the row will be flagged as OK.  Note that for each plane 
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and combination, the program will bold the text for those drift % 

values that exceed the allowable.   

 

4.2.5 Maximum Drift Envelope  

This sheet reports the maximum drift % against the maximum 

allowable drift % for all combinations and all columns at a plane. 

The % drift for the selected directions are shown as well as the 

allowable %. If any of the direction values (X, Y or combined) 

exceed the allowable the program will flag this row (indicating a 

single column for a single load combination result) as NG.  If the 

values are less than allowable the row will be flagged as OK.   
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4.2.6 Average Drift Envelope 

This sheet reports the maximum average drift % against the 

maximum allowable drift % for all combinations and all columns 

at a plane. The % drift for the selected directions are shown as well 

as the allowable %. If the any of the direction values (X, Y or 

combined) exceed the allowable the program will flag this row 

(indicating a single column for a single load combination result) as 

NG.  If the values are less than allowable the row will be flagged 

as OK.  Note that the program will bold the text for those drift % 

values that exceed the allowable.   

 

4.2.7 Drift Amplification Factor 

This sheet reports the directional drift amplification % for selected 

P-Delta combinations. Results are shown for each column at every 

plane in the structure and code checked against the user-defined 

maximum allowable.  %. If  any of the direction values (X, Y or 

combined) exceed the allowable the program will flag this row 

(indicating a single column for a single load combination result) as 

NG. If the values are less than allowable the row will be flagged as 

OK.  The ratio can be taken as the 2nd order drift/1st order drift.  

The program calculates drift values at the top and bottom of each 

column.  The program calculated drifts at both locations and uses 

the maximum ratio for this report.  
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4.3 Felt 3D Reports  

When the ‘PT Shop/FELT 3D’ module is selected in the program splash 

screen, additional features are added to the Tendon ribbon in the ‘Shop 

Drawing’ panel.  These are shown below and were described in more 

detail in Section 2.5 of this document.   

 

 

If modeled tendons have been set to use the Calculated Long-Term Loss 

option, the program will generate a compiled PDF report summarizing 
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tendon loss calculations including graphical views of the tendons 

horizontal and vertical profile and the loss diagrams.  The ‘Friction and 

Elongation’ calculation option should be processed before producing the 

report.   

The report can be produced for a selected tendon/s or all tendons if none 

are selected.  Depending on the number of tendons being processed, the 

report can take several minutes to produce and is done so as a .PDF 

document.  The reports are saved in the model solution folder in a sub-

folder called “FeltDesign.”  Select the button called ‘FELT 3D Report’ 

from the panel shown above or use Reports→Tendon→PDF 

Reports→Felt 3D Report or FELT 3D-Single Strand Report.  Note the 

pull-down arrow on the panel button allows the Single Strand option to be 

selected.  When using the Single Strand option the program produces the 

report for a single tendon if the modeled tendon contains multiple strands.  

If this option is not used, the calculations will be based on the total of all 

strands for the modeled tendon.  In this context a “strand” refers to a 

single tendon or cable.  An example of a completed FELT 3D report is 

shown below.   
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